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AN87391 では PSoC 4 に内蔵された LCD ドライバーを使用してセグメント LCD を容易に駆動する方法を紹介します。PSoC
4 は複数の LCD 駆動モード、低消費電力性を持ち、ユーザー インターフェースとシステム ソリューションを提供します。本アプリ
®
ケーション ノートでは、サンプル プロジェクトにより、低消費電力 LCD の設計、および CapSense を含むユーザー インターフェース
ソリューションを説明します。
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はじめに
血糖値計、マルチメータや血圧計など消費電力が小さいポータブル機器の多くは、セグメント LCD を使って情報を表示します。
セグメント LCD はマイクロコントローラーとインターフェースするために外部ドライバーを必要とします。PSoC 4 はセグメント
LCD を直接駆動できる低消費電力 LCD ドライバーを実装しています。
PSoC 4 は単一のチップに、コンフィグレーション可能なアナログとデジタル ペリフェラル機能、静電容量式タッチセンス、
®
®
メモリおよび 32 ビット ARM Cortex -M0 マイクロコントローラーを内蔵している真のプログラマブル組み込みシステム オン
チップです。PSoC 4 は市場投入までの時間を加速し、重要なシステム機能を統合し、システム全体のコストを削減します。
PSoC 4 の静電容量タッチセンス機能 (CapSense) は LCD 駆動と共に、1 個の PSoC 4 だけでユーザー インターフェ－ス
ソリューションの実装が可能です。
PSoC 4 は消費電力を低減するフレキシブルな低消費電力モードを持ちます。例えば、PSoC がディープスリープモードである
場合、セグメント LCD の消費電流は 3.1μA もの低さになります。
PSoC Creator™ IDE は、異なるタイプのセグメント LCD モジュールを PSoC 4 と共に使いやすくするセグメント LCD コンポーネ
ントを提供します。
本アプリケーションノートはサンプル プロジェクトによって、PSoC 4 のセグメント LCD 駆動によってもたらされる特長について
説明し、消費電力が小さい LCD 設計のベストプラクティス、ユーザー インターフェース ソリューションを示します。
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®
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®
PSoC 4 を初めてご使用になる場合は AN79953 - Getting Started with PSoC 4 を参照ください。PSoC Creator を初めて
ご使用になる場合は PSoC Creator のホームページを参照ください。PSoC 4 の電力モードのガイドは AN86233 - PSoC 4
Low-Power Modes and Power Reduction Techniques を参照ください。
2
PSoCリソース
サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに適切な PSoC デバイスを選択し、
デバイスをデザインに迅速で効果的に統合する手助けをしています。リソースの包括的なリストについては KBA86521 How to Design with PSoC 3, PSoC 4, and PSoC 5LP を参照ください。以下は PSoC 4 のリソース要約です:



製品セレクター: PSoC 1、PSoC 3、PSoC 4 ま
たは PSoC 5LP。さらに、PSoC Creator にはデ
バイス選択ツールが含まれています。
テクニカル リファレンス マニュアル (TRM): 各 PSoC 4 デ
バイス ファミリのアーキテクチャとレジスタの詳細な説明
をします。

開発キット:

データシートは PSoC 4 デバイス ファミリの電気
的仕様を説明します。

CapSense デザイン ガイド: PSoC 4 ファミリの
デバイスを使用して静電容量タッチセンス アプ
リケーションを設計する方法について説明します。

2.1
概要: PSoC ポートフォリオ、PSoC ロードマップ
アプリケーション ノートおよびサンプル コードは
基本的なレベルから高度なレベルまでの幅広い
トピックに触れています。アプリケーション ノート
の多くはサンプル コードを含んでいます。PSoC
Creator はより多くのサンプル コードをご提供し
ます。詳細については「サンプル コード」を参照
ください。


CY8CKIT-040 、 CY8CKIT-042 、 CY8CKIT-044 、
CY8CKIT-046およびPSoC 4 Pioneer Kitsは使いや
すく、安価な開発プラットフォームです。これらのキット
に は Arduino™ 準 拠 シ ー ル ド お よ び Digilent®
Pmod™ドーター カード用コネクタを搭載します。

CY8CKIT-049およびCY8CKIT-043はPSoC 4デバイス
をサンプリングするための低コスト プロトタイプ プラット
フォームです。

CY8CKIT-001はすべてのPSoCファミリ デバイスの
共通開発プラットフォームです。
MiniProg3 デバイスはフラッシュのプログラムとデバッグ
用のインターフェースを提供します。
PSoC Creator
PSoC Creator は Windows ベースの統合設計環境 (IDE) です。無料で利用できます。このキットにより、PSoC 3、PSoC 4
および PSoC 5LP ベースのシステムについて、ハードウェアとファームウェアの同時並行の設計が可能です。図 1 に示すように、
PSoC Creator により以下のことが可能です:
1.
2.
コンポーネントをドラッグ アンド ドロップして、メ
イン デザイン ワークスペースでハードウェア シ
ステム デザインを構築
PSoC ハードウェアとアプリケーション ファーム
ウェアを同時設計
www.cypress.com
3.
4.
5.
コンフィギュレーション ツールを用いて、コンポーネントを
構成
100 以上のコンポーネントを含むライブラリを利用
コンポーネント データシートの閲覧
文書番号: 002-11594 Rev. **
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図 1. PSoC Creator の特長
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2.2
図 2. PSoC Creator のサンプル コード
サンプル コード
PSoC Creator は多数のサンプル コード プロジェクトを提供しています。
これらのプロジェクトは図 2 に示すように、PSoC Creator のスタート
ページからアクセスできます。
サンプル プロジェクトにより、空のページではなく出来上がった設計を
元に始めるため、設計時間を短縮することができます。サンプル プロ
ジェクトは PSoC Creator コンポーネントを様々なアプリケーションに
使用する方法も示します。図 3 が示すように、サンプル コードおよび
データ シートが含まれています。
図 3 に示す「Find Example Project」ダイアログには、いくつかのオプ
ションがあります:

アーキテクチャまたはデバイス ファミリ (PSoC 3、PSoC 4、
PSoC 5LP) またはカテゴリやキーワードに基づいてサンプル
プロジェクトをフィルターします。

Filter Options に基づいて絞り込まれたサンプル プロジェクトの
メニューから選択します。

Documentation タブで、選択されたプロジェクトのデータシートを確
認します。

選択したサンプル コードを確認します。このウィンドウ
からコードをコピーし、プロジェクトに貼り付けてコード開発時間を
短縮することができます。

選択したものをベースに新規プロジェクト (また必要な場合は
新規ワークスペース) を作成します。出来上がった基本的な設計
を元に始めることで設計時間を短縮します。サンプル設計を、所
望のアプリケーションに変えて行きます。
図 3. サンプル コードを含むサンプル プロジェクト
www.cypress.com
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2.3
PSoC Creatorヘルプ
PSoC Creator ホームページへアクセスし、PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を
起動して以下のアイテムへナビゲートします:
2.4

クイック スタート ガイド: Help > Documentation > Quick Start Guide を選択します。このガイドは PSoC Creator
プロジェクトを開発するための基礎知識を提供します。

簡単なコンポーネント サンプル プロジェクト: File > Open > Example projects を選択します。これらのサンプル
プロジェクトは PSoC Creator のコンポーネントの設定と使用方法を説明します。

Starter designs (初級者向けの設計): File > New > Project > PSoC 4 Starter Designs を選択します。これらの
初級者向けの設計は、PSoC 4 のユニークな機能を説明します。

システム リファレンス ガイド: Help > System Reference > System Reference Guide を選択します。このガイドは
PSoC Creator により提供されるシステム機能を一覧で説明します。

コンポーネント データシート: コンポーネントを右クリックして「データシートを開く」を選択します。全ての PSoC 4 のコンポーネ
ント データシートの一覧を表示するには、PSoC 4 のコンポーネント データシートページへアクセスしてください。

ドキュメント マネージャー: PSoC Creator が提供するドキュメント マネージャーにより、ドキュメント リソースを容易に検
索し、閲覧することができます。ドキュメント マネージャーを開くには、メニューアイテムの Help > Document Manager
を選択します。
テクニカル サポート
ご質問には弊社のテクニカル サポート チームが対応させて頂きますので、お気軽にご連絡ください。Cypress Technical
Support ページにアクセスし、サポート リクエストを作成してください。
米国のお客様はテクニカル サポート チームに連絡する際、以下の電話番号 (通話無料) にお問い合わせください: +1-800541-4736 プロンプトでオプション「8」を選択してください。
緊急サポートが必要な場合は、以下のサポート リソースをご利用ください。

セルフ ヘルプ
www.cypress.com
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お近くの販売代理店
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3
PSoC 4 のセグメントLCD駆動の特長
PSoC 4 のセグメント LCD 駆動は以下の特長があります:







最大 8 コモン (COM) と 56 セグメント (SEG) 電極をサポート
PSoC 4 のプログラマブル GPIO により、COM と SEG の電極のフレキシブルな選択が可能
14 セグメントと 16 セグメント構成のキャラクタ型ディスプレイ、7 セグメント構成のディスプレイ、ドット マトリクスおよび
特殊記号をサポート
2 つの駆動モード: デジタル相関および PWM
PSoC 4 のアクティブ、スリープ、ディープスリープの電力モードで動作
1.8 ボルトの VDD から 3 ボルトのディスプレイを駆動することが可能
デジタル コントラスト制御
注意: サポートされるコモンとセグメントの数はデバイス ファミリとデバイス パッケージによって異なります。詳細はそれぞれの
デバイスのデータシートを参照ください。
4
セグメントLCDの基本
セグメント LCD は 1 対の電極の間に液晶材料があります。個々の LCD セグメントの上部と下部の電極は、それぞれコモン
(COM)とセグメント (SEG) 電極と呼ばれています。図 4 に示すように、これらの電極はマトリックスを形成します。
図 4. COM と SEG の電極
LCD Panel
Resistance
COM3
COM2
COM1
SEG0
SEG1
COM0
図 4 のコンデンサは、LCD セグメントの等価静電容量を表します。各対の COM と SEG 電極は 1 つの LCD セグメントのみ
で接続されています。COM-SEG 電極対の両端にかかる二乗平均平方根 (RMS) 電圧は、対応する LCD セグメントの透明
度を制御します。
www.cypress.com
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液晶材料は DC 電圧に長時間耐えられません。したがって、COM および SEG 電極間に印加される波形はそれぞれの LCD
セグメントで DC 成分を 0V とする必要があります。駆動波形は複数の LCD セグメントを同時に有効にするための時分割多
重化を含んでいます。一般の LCD ドライバーは COM と SEG 電極で複数の電圧ステップで AC 波形を生成します。以下の
用語はこれらの波形を定義するのに使用されます:

デューティ: M 個の COM 電極を駆動する場合、ドライバーは 1/M デューティで動作すると言われます。各 COM 電極は
実効的に 1/M 時間駆動されます。PSoC 4100 および PSoC 4200 デバイスは 1/2、1/3 および 1/4 のデューティをサポートし
ます。PSoC 4100M、4200M、4100L および 4200L デバイスは 1/2、1/3、1/4 および 1/8 のデューティをサポートします。

バイアス: ドライバーの波形が (1/B) × VDRV の電圧ステップを使用する場合、ドライバーは 1/B バイアスを使用すると
言われます。VDRV はシステムで最も高い駆動電圧 (PSoC 4 での VDD と同じ) です。PSoC 4100 および PSoC 4200
デバイスは PWM 駆動モードで 1/2 および 1/3 のバイアスをサポートします。PSoC 4100M、4200M、4100L および
4200L デバイスは PWM 駆動モードで 1/2、1/3、1/4 および 1/5 のデューティをサポートします。詳細は 11 ページの表 1
を参照ください。

フレーム: フレームはすべてのセグメントを駆動するために必要な時間の長さです。フレームの間に、ドライバーは順序に
従って COM 電極を通じて信号を変化させます。フレーム全体を測定するとき、すべてのセグメントで 0V DC (実効値は
0 ではない) となります。
セグメント LCD ピクセルの強度またはコントラストはピクセルに適用する RMS 電圧に依存します。図 5 に LCD セグメントの
コントラストおよび RMS 電圧の関係を示します。
図 5. RMS 電圧とコントラストの関係
100%
Contrast (C)
90%
Discrimination Ratio:
D= VHI/VLo
10%
0%
VOFF
VTHR VLO
VHI VON
AC Voltage between COM and SEG (VRMS)
図 5 の用語は以下のように定義されます:






VOFF: ピクセルにかかる RMS 電圧であり、それ以下でコントラスト変化が LCD に表示されません。
VTHR: 10％コントラストが達成されたピクセルにかかる RMS 電圧です。
VON: 90％コントラストが達成されたピクセルにかかる RMS 電圧です。
VLO: LCD ドライバーが生成できる最低の RMS 電圧です。
VHI: LCD ドライバーが生成できる最高の RMS 電圧です。
識別比率 (D): ドライバーが実現できる VHI と VLO との比率です。識別比率が高いとコントラストが良くなります。
ツイスト ネマチック (TN) とスーパー ツイスト ネマチック (STN) ディスプレイは、セグメント LCD の最も一般的に利用可能な
タイプです。TN ディスプレイは STN ディスプレイに比べて透明度の顕著な違いを生成するために RMS 電圧の高い変化を
必要とします。従って、所定の識別比率に対して STN ディスプレイは TN ディスプレイより優れたコントラストを提供します。
STN ディスプレイは優れた視野角もあります。しかし、TN ディスプレイは一般的に STN ディスプレイより安価です。
セグメント LCD の基本の詳細については PSoC 4 テクニカル リファレンス マニュアル (TRM) を参照ください。
www.cypress.com
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5
PSoC Creatorコンポーネント: セグメントLCD
PSoC Creator は、異なるタイプのセグメント LCD モジュールと PSoC 4 をインターフェースしやすくするセグメント LCD
コンポーネントを提供します。コンポーネントを PSoC Creator のプロジェクト回路図にドラッグ&ドロップして LCD モジュール
を設定します。また、コンポーネントは使いやすいアプリケーション プログラミング インターフェース (API) を提供します。詳細
は PSoC 4 セグメント LCD コンポーネント データシートを参照ください。
プロジェクト「セグメント LCD の基本」も参照ください。このプロジェクトはセグメント LCD コンポーネントおよび API を使用して
PSoC 4 と 7 セグメント構成の 4 桁 LCD モジュールをインターフェースする方法を示します。
6
PSoC 4 セグメントLCDの直接駆動
PSoC 4 は PWM およびデジタル相関という 2 つのセグメント LCD 駆動モードをサポートします。それらは LCD に必要な AC
波形を生成するために異なる技術を使用し、異なるコントラストおよび消費電力特性を持っています。次のセクションは 2 つの
駆動モードの違いについて詳細に説明します。
6.1
PWM駆動モード
PWM 駆動モードは高周波 (32kHz〜48MHz) の PWM デジタル信号を使用して、LCD セグメントにかかる低周波 (30〜
150Hz) のアナログ駆動波形を生成します。図 6 に示す通り、LCD セグメントの静電容量およびパネル抵抗は、LCD セグメン
トに与える電圧を生成するために、高周波の PWM 信号をフィルターします。
図 6. PWM 駆動モード
GPIO Output Impedance
LCD Panel Resistance
LCD Segment
Capacitance
PWM Generator
COM
V1
V2
PWM Generator
SEG
Voltage at GPIO
(V1)
Vddd
0
t
Effective voltage across a pixel
(V2)
Vddd
2/3 Vddd
1/3 Vddd
0
t
www.cypress.com
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6.2
デジタル相関駆動モード
デジタル相関駆動モードは、低消費電力でバッテリ駆動アプリケーションに最適な特許出願中のサイプレスの発明です。非
アクティブ フレーム間隔で COM 信号の駆動周波数を 2 倍にすることによって動作します。これはセグメントにかかる VRMS を
変更して、その結果、セグメントのコントラストに影響を与えます (図 5 を参照)。図 7 にデジタル相関モード波形の例を示します。
図 7. デジタル相関の例
One ‘Frame’ of LCD drive
(addresses all segments once)
VDD
COM0
0
VDD
COM1
0
VDD
SEG0
0
SEG1
VDD
0
t0
t1
t2
t3
One Frame
COM / SEG is selected
COM / SEG is not selected
Resulting voltage across segments
(VDC = 0)
COM0 -SEG0
VDD
0
-VDD
Segment ON:
VRMS = 0.791 VDD
COM0 -SEG1
VDD
0
-VDD
Segment OFF:
VRMS = 0.612 VDD
VDD
COM1 -SEG0
Segment ON:
VRMS = 0.791 VDD
0
-VDD
VDD
COM1 -SEG1 0
-VDD
Segment OFF:
VRMS = 0.612 VDD
t0
t1
Segment is On
Segment is Off
t2
t3
Discrimination ratio:
D = 0.791/0.612 = 1.291
各駆動モードとそれに対応する波形の詳しい説明は PSoC 4 テクニカル リファレンス マニュアルを参照ください。
セグメント LCD は RC 直列回路の特性を持ちます。従って、消費電力は動作周波数に依存します。デジタル相関駆動モード
は、動作周波数が非常に低いため、PWM 駆動モードよりかなり少ない消費電流になります。
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しかし、PWM モードのコントラストと視野角は、デジタル相関モードよりも優れています。これは PWM モードが高い識別比率
(図 5) を持つためです。表 1 に識別比率の比較を示します。
表 1. 識別比率の比較
識別比率
COM
PWM
PWM
1/4 バイアス
1/5 バイアス
2.236
1.844
1.612
1.732
1.915
1.732
1.567
1.291
1.528
1.732
1.648
1.528
1.134
1.254
1.414
1.581
1.494
デジタル相関
PWM 1/2 バイアス
PWM 1/3 バイアス
2
1.732
2.236
3
1.414
4
8
これらの駆動モード間のコントラストと視野角の実際の差は、LCD モジュールの特性に依存します。
6.3
低消費電力動作
PSoC 4 セグメント LCD ドライバを使用する時、消費電力を削減するために以下の手順に従ってください:
1.
AN86233 - PSoC 4 Low-Power Modes and Power Reduction Techniques を参照し、この文書で説明した手法を実
装してシステム全体の消費電力を削減してください。
2.
可能な限りディープ スリープ モードに移行してください。ディープ スリープモードは、セグメント LCD の駆動能力を保持した
PSoC 4 で最も低い電力モードです。
3.
デバイスはディープ スリープ モードのとき、セグメント LCD のデジタル相関駆動モードを使用してください。
PWM 駆動モードに比べて、デジタル相関モードは TN ディスプレイに対して少しコントラストと視野角が低くなり、STN ディス
プレイに対してはコントラストまたは視野角に大差はありません。しかしデジタル相関モードは PWM モードより電流の消費が
非常に少なくなります。表 2 は 2 つの駆動モードの電流消費量を比較し、表 3 は駆動モードの推奨使用方法を示します。
注: 表 2 は PSoC 4200 デバイスで 3 COM、12 SEG LCD のおおよその消費電流を示します。実際の消費電力はデバイス
ファミリ、使用された LCD のタイプおよびファームウェアに依存します。
表 2. セグメント LCD が有効の時のディープ スリープ モードでの標準的なデバイス消費電流
フレーム レート
(Hz)
www.cypress.com
消費電流 (µA)
デジタル相関モード
PWM モード
30
3.1
65.9
50
3.8
66.2
70
4.5
66.5
90
5.1
66.7
110
5.8
67.1
130
6.5
67.3
150
7.4
67.6
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表 3. 低消費電力動作を考慮した駆動モードの推奨使用方法
ディスプレイ タイプ
TN LCD
STN LCD
ディープスリープ
モード
アクティブおよびスリープ
モード
デジタル相関
PWM
デジタル相関
備考
ファームウェアは動的に LCD 駆動モードを切り替える必要がある
STN LCD を使用する時、PWM ドライブはコントラストに関して利点
がない
消費電力とディスプレイのコントラストとの間で最適なバランスを得るために実行中に LCD 駆動モードを変更することができ
ます。図 8 にアクティブ モードでの良好なコントラストと視野角、およびディープ スリープ モードでの消費電力の低減のために
LCD 駆動モードを動的に切り替えるファームウェアの流れを示します。
詳細については「低消費電力セグメント LCD」プロジェクトを参照ください。
図 8. 低消費電力 LCD 動作のファームウェアの流れ
Active mode: Run LCD in PWM mode to get
better contrast and viewing angle
Go to Digital Correlation drive mode before
going to Deep-Sleep mode
Call the Deep-Sleep API
Go back to PWM mode when the processor
goes back to active mode
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7
PSoC 4 ユーザー インターフェース ソリューション
このセクションでは PSoC 4 のみを使用してユーザー インターフェース (UI) ソリューションを作成する方法について説明しま
す。このセクションの内容を理解するために、PSoC 4 CapSense の基本的な知識を身に付ける必要があります。CapSense
の基本を理解するために PSoC 4 CapSense 設計ガイドを参照ください。
PSoC 4 の CapSense 機能はかつてない信号対雑音比 (SNR)、クラス最高の耐水性および多種多様なセンサー (ボタン、
スライダー、トラックパッドや近接センサなど) を提供します。優雅で、信頼性が高く、電力効率が良く、使いやすい UI ソリュー
ションを作成するために、CapSense と低消費電力モードと共にセグメント LCD 駆動を使用することができます。
図 9 に PSoC がセグメント LCD を駆動し、タッチパネルをスキャンする UI サンプルを示します。タッチパネルは 2 つの
CapSense ボタンとスライダーで構成されています。
図 9. PSoC 4 ユーザー インターフェースの例
Segment LCD
PSoC 4
Touch Panel
CapSense
Button
CapSense Slider
CapSense
Button
CapSense はディープ スリープ モードでセンサーをスキャンすることはできないため、デバイスは周期的に復帰してセンサー
をスキャンする必要があります。センサーのスキャン中、PSoC 4 はアクティブ モードでなければなりません。消費電力を節約
するために、ディープ スリープ モードの時間を長く、アクティブ モードの時間を短く動作させる必要があります。
CapSense がタッチを検出すると PSoC 4 はアクティブ モードのままとなり、タッチ パネル入力を読み出すために各センサー
を個別にスキャンします。パネルが再び非アクティブになると、デバイスはディープ スリープ モードに戻ります。
PSoC 4 CapSense は複数のセンサーを一つにまとめて、単一のセンサーとしてスキャンすることができます。これはアクティブ
モードの総時間を削減します。
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図 10 に低消費電力のユーザー インターフェース (UI) ソリューションのサンプル ファームウェアの流れを示します。
図 10. 低消費電力 UI ソリューションのファームウェアの流れ
Scan all CapSense sensors individually.
Change LCD drive mode to PWM
Check if the touch panel is
inactive
No
Yes
Change LCD drive mode to Digital
Correlation. Enter Deep-Sleep mode.
Timed wakeup
Bundle all the sensors together and
scan as a single sensor
Touch
detected ?
No
Yes
詳細は「セグメント LCD および CapSense ユーザー インターフェース」プロジェクトを参照ください。このプロジェクトは 7 セグ
メント構成の 4 桁 LCD および 5 素子 CapSense スライダーのユーザー インターフェースを示します。
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PSoC Creatorプロジェクト
このアプリケーション ノートでは 4 つのサンプル プロジェクトを紹介します:
1.
セグメント LCD の基本: これは PSoC Creator PSoC 4 セグメント LCD コンポーネントの基本的な使用法を説明するための
シンプルなプロジェクトです。
2.
低消費電力セグメント LCD: このプロジェクトは消費電力を極めて低く抑えてセグメント LCD コンポーネントを使用する
方法を示します。
3.
セグメント LCD と CapSense ユーザー インターフェース: このプロジェクトはセグメント LCD と CapSense コンポーネントを
使用するユーザー インターフェース ソリューションの作成方法を示します。
プロジェクト 1 と 2 を評価するために、PSoC 4 キットあるいはお持ちのハードウェアを使用できます。プロジェクト 3 は
サイプレス CY8CKIT-042 が必要です。
3 つのプロジェクトは、3 つの COM 電極と 12 の SEG 電極がある 7 セグメント構成 4 桁の VIM 404 セグメント LCD モ
ジュールが必要です。詳しい回路図については、20 ページの図 17 を参照ください。
4.
8.1
キャラクタ型セグメント LCD: このプロジェクトは PSoC 4100M / 4200M デバイスで使用可能な多数の GPIO を利用して、
4 つの COM 電極および 32 の SEG 電極がある 14 セグメント構成 8 桁の VIM-828 セグメント LCD モジュールを駆動し
ます。このプロジェクトはサイプレスの CY8CKIT-043 または CY8CKIT-046 と VIM-828 セグメント LCD モジュールが必
要です。
プロジェクト 1: セグメントLCDの基本
このプロジェクトを作成するために、以下のようにしてください:
1.
新しい PSoC 4 プロジェクトを作成します。PSoC Creator を初めてご使用になる場合は PSoC Creator のホームページ
を参照ください。
2.
セグメント LCD コンポーネントとクロック コンポーネントを TopDesign 回路図にドラッグ アンド ドロップします。図 11 に
示すように、それらを一緒にワイヤーで接続します。
図 11. LCD とクロックの接続
3.
セグメント LCD コンポーネントをダブルクリックし、設定ウィンドウを開きます。
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4.
コンポーネント コンフィギュレーション ダイアログで、General タブを設定します。図 12 に示すように、LCD 駆動設定を
選択します。
図 12. セグメント LCD コンフィギュレーションの「General」タブ

VIM 404 セグメント LCD モジュールに合わせるために、コモンとセグメントのライン数をそれぞれ 3 と 12 にセットし
ます。



PWM 駆動モードを使用します。9 ページの PSoC 4 セグメント LCD の直接駆動を参照ください。

残りの設定はそれぞれ初期値のままにしておきます。
VIM 404 セグメント LCD モジュールで良いコントラストを得るため、1/2 バイアスを選択します。
Type B 波形を選択します。Type B 波形は Type A 波形より消費電力がわずかに少なくなります。これらの波形の
詳細については、PSoC 4 テクニカル リファレンス マニュアルを参照ください。
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5.
Display Helpers タブを設定します。このタブは SEG および COM 電極をディスプレイ モジュールにマッピングします。
このタブを設定するのに、LCD モジュールのデータシートを参照します (VIM-404 を参照ください)。
この LCD モジュールは 7 セグメント構成で 4 桁あります。7 セグメント ディスプレイ ヘルパーを追加するために Helpers
リストボックス内で 7 Segment を選択し、
ボタンをクリックします。図 13 に示すように、選択したディスプレイ機能
が Selected helpers リスト ボックスに見えます。
図 13. ディスプレイ ヘルパーの追加
LCD モジュールは 7 セグメント構成の 4 桁です。
www.cypress.com
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6.
図 14 に示すように、該当する桁からセグメントをドラッグし、ピクセル マッピング テーブルにドロップします。VIM 404
LCD モジュールのピクセル マッピングについては、VIM-404 データシートを参照ください。
図 14. ピクセル マッピングの手順
www.cypress.com
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7.
ディスプレイの各セグメントに対し、同じプロセスを繰り返します。全てのピクセルをマッピングすると、テーブルは図 15 の
ように完成します。
図 15. 完成したピクセル マッピング テーブル
www.cypress.com
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8.
OK をクリックします。これでセグメント LCD コンポーネントの設定は完了します。図 16 に示すように、コモンとセグメント
にピンを割り当てるために、.cydwr (デザインワイド リソース) ファイルを開き、ピンを割り当てます。
注: ここに示すピン割り当ては CY8CKIT-042 開発キット用です。異なるキットをご使用になる場合、キット ユーザー ガイドを
参照して、キットのいずれかの周辺機器に接続されない適切なピンを選択してください。
図 16. ピン割り当て
9.
図 17 に示すように、VIM 404 LCD を PSoC 4 に配線します。これは個別の PCB または CY8CKIT-042 キットおよび
Arduino ProtoShield 基板で行うことができます。
図 17. PSoC 4 から LCD モジュールへの外部接続
3.3V
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P3[4]
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16
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1
2
3
4
5
6
7
8
9
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www.cypress.com
P2[4]
P0[4]
P0[5]
P0[7]
文書番号: 002-11594 Rev. **
20
®
PSoC 4 セグメント LCD の直接駆動
10. ファームウェアをプロジェクトに追加します。1、2、3、...9、0 の数字がスクロールする表示をさせるために、コード 1 の
コードを main.c に追加します。
セグメント LCD コンポーネントはすぐに使える API を提供します。API 関数の詳細については、PSoC 4 セグメント LCD
コンポーネント データシートを参照ください。
コード 1. LCD で数字がスクロールする
#include <device.h>
/* Macro for a black space on the 7-segment LCD */
#define BLANK (16u)
/* Macro for scrolling length */
#define SCROLL_LENGTH (14u)
/* Macro for initial scrolling value */
#define INITIAL_VALUE (0u)
/* Define the numbers used for scrolling the 4-digit display */
#define SCROLL0 (0u)
#define SCROLL1 (1u)
#define SCROLL2 (2u)
#define SCROLL3 (3u)
#define DIGIT0
(0u)
#define DIGIT1
(1u)
#define DIGIT2
(2u)
#define DIGIT3
(3u)
/* Define the loop delay */
#define LOOP_DELAY (512u)
void main()
{
/* This variable is used to index the character array */
uint8 index = 0;
/* Array of scrolling numbers including blank spaces to improve visibility */
uint8 numbers[] = {BLANK, BLANK, BLANK, BLANK,
1, 2, 3, 4, 5, 6, 7, 8, 9, 0, BLANK, BLANK, BLANK};
/* Starts the Segment LCD Component */
LCD_Start();
for(;;) /* do forever */
{
/* Scroll the blanks and numbers stored in the array, from right to left */
for(index = INITIAL_VALUE; index < SCROLL_LENGTH; index++)
{
/* Print the numbers on the LCD glass */
LCD_Write7SegDigit_0(numbers[index + SCROLL3], DIGIT0);
LCD_Write7SegDigit_0(numbers[index + SCROLL2], DIGIT1);
LCD_Write7SegDigit_0(numbers[index + SCROLL1], DIGIT2);
LCD_Write7SegDigit_0(numbers[index + SCROLL0], DIGIT3);
/* Give delay for a visible scrolling */
CyDelay(LOOP_DELAY);
}
}
}
11. PSoC 4 が 3.3V VDD 電源で動作している事を確認してください。デバイスをプログラムし、LCD ディスプレイを表示して出
力を検証します。図 18 に示すように、右から左へ 1、2、3、...、9、0 の数字がスクロールします。
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図 18. LCD ディスプレイ モジュール 数字のスクロール
ディスプレイのコントラストが高すぎる場合、セグメント LCD コンポーネントのコントラストを減らし、デバイスを再度プログラム
します。
8.2
プロジェクト 2: 低消費電力セグメントLCD
このプロジェクトは平均消費電力を低減するためにプロジェクト 1 を変更したものです。
消費電力を低減するために、PSoC 4 が表示を更新し、数字を 1 桁スクロールする時間だけアクティブ モードにします。これ
には約 720µs かかります。その後デバイスは、512ms 間のディープ スリープモードに遷移します。図 19 にタイミング図を示
し、図 20 にファームウェアの流れを示します。
この手法では、PSoC 4 は 11µA 未満の平均電流を消費します。表 4 に 2 つのプロジェクトの消費電流の概算値の比較を示
します。
表 4. 消費電流の比較
電力モード
アクティブ
ディープスリープ
平均電流
プロジェクト 1
このプロジェクト
2.7mA
2.7mA
なし
7µA
2.7mA
10.9µA
図 19. プロジェクト 2 のタイミング図
Deep-sleep
512ms
Current
2.7mA
720µs
Active
7µA
time
Powered On
www.cypress.com
文書番号: 002-11594 Rev. **
22
®
PSoC 4 セグメント LCD の直接駆動
図 20. プロジェクト 2 のファームウェアの流れ
Change LCD drive mode to Digital
Correlation
Go to Deep-Sleep
Wait 512mS
Come back to Active
Change LCD drive mode to PWM.
Display next digit.
このプロジェクトはウォッチドッグ タイマー (WDT) 割り込みを生成するためにグローバル信号コンポーネントを使用します。
図 21 に示す通り、コンポーネントを設定します。WDT は 512ms 毎に割り込みを生成するように設定されます。図 22 にこの
プロジェクトの TopDesign 回路図を示します。
図 21. グローバル信号コンポーネントの設定
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図 22. プロジェクト 2 の LCD TopDesign 回路図
プロジェクトをテストするために、デバイスをプログラムし、プロジェクト 1 (図 17) のようにディスプレイを接続し、出力を確認し
ます。数字のスクロール表示は同じですが、このプロジェクトの消費電力はかなり削減されます。
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8.3
プロジェクト 3: セグメントLCDおよびCapSenseユーザー インターフェース
このプロジェクトでは CapSense タッチセンスと表示用セグメント LCD からなるユーザー インターフェース (UI) を紹介します。
UI コントローラーはユーザー入力の待ち受けにほとんどの時間を費やします。電力効率のよい実装をするため、PSoC 4 は
周期的にディープ スリープモードに入ります。
注: このプロジェクトはたいへん短いスキャン時間と低い消費電力を達成するために CapSense ウィジェットの手動チュー
ニングを使用します。このプロジェクトを理解するために CapSense の手動チューニングの知識が必要です。手動チューニング
の詳細については、PSoC 4 CapSense 設計ガイドを参照ください。
このプロジェクトは CapSense 能力を追加するようにプロジェクト 2 を変更したものです。図 23 にタイミング図を示し、図 24
にこのプロジェクトの TopDesign 回路図を示し、図 25 にファームウェアの流れを示します。
このプロジェクトでは、CapSense が高速タッチを検出するよう頻繁にセンサーをスキャンするため、PSoC 4 は 128ms の
間だけディープ スリープ モードに入ります。復帰すると CapSense は全てのスライダー素子を 1 つにまとめ、1 つの近接セン
サーとしてスキャンします。いずれかのスライダー素子がタッチされると、近接センサーはタッチを検出し、その後で各素子は
スライダー タッチ位置を確定するために個別にスキャンされます。スライダー位置はその後、LCD 上に表示されます。
タッチを検出した後で、全ての CapSense ウィジェットが 128ms の間非アクティブである場合、デバイスはディープスリープ
モードに戻ります。タッチを検出しない場合、PSoC 4 の平均消費電流は 21µA 以下です。
図 23. プロジェクト 3 のタイミング図
Deep-sleep
128ms
Current
3.5mA
500µs
Active
7µA
time
Powered On
図 24. プロジェクト 3 の TopDesign 回路図
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図 25. プロジェクト 3 のファームウェアの流れ
Change LCD drive mode to PWM
Scan the slider and display the finger position.
Sensor inactive
for 128 mS ?
No
Yes
Change LCD drive mode to Digital
Correlation. Enter Deep-Sleep mode.
WDT wakeup after
128 mS
Bundle all the sensors together and
scan as a single sensor
Touch
detected ?
No
Yes
プロジェクトをテストするために図 17 のように LCD を接続し、スライダーをタッチし、LCD が指の位置を表示することを確認し
ます。スライダーが非アクティブの時、LCD はデバイスがディープスリープ モードにあることを示すように「dSLP」を表示します。
初期値の CapSense パラメーターを、所与の条件で CY8CKIT-042 用に手動で調整することに注意して下さい。タッチ応答
性が悪い場合、CapSense を手動で再度調整する必要があります。別の方法として、すべてのパラメータを最適な値に自動
的に設定するファームウェア アルゴリズムである SmartSense™の使用があります。詳細は PSoC 4 CapSense 設計ガイド
を参照ください。SmartSense を使用すると消費電力が増える事に注意してください。このプロジェクトに SmartSense を使用
すれば、平均消費電力は概ね 40µA です。
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8.4
プロジェクト 4: キャラクタ型セグメントLCD
このプロジェクトは PSoC 4100M/4200M/4100L/4200L デバイスで使用可能な多数の GPIO を利用して、4 つの COM 電極、
32 の SEG 電極がある 14 セグメント構成 8 桁の VIM-828 セグメント LCD モジュールを駆動します。このプロジェクトはサイ
プレスの CY8CKIT-043 または CY8CKIT-046 と VIM-828 LCD が必要です。
セグメント LCD コンポーネントは、14 セグメント構成のキャラクタ型ディスプレイに文字列を表示するために、豊富な API を提供
します。このプロジェクトは VIM-828 に「PSoC4200」の文字を表示します。詳細は PSoC Creator プロジェクトを参照ください。
表 5 に VIM-828 から CY8CKIT-43 または CY8CKIT-46 への配線情報を示します。
表 5. 配線情報
LCD ピン番号
LCD ピン機能
CY8CKIT-43 接続先
CY8CKIT-046 接続先
1
COM3
P0[7]
P2[0]
2
SEG0
P0[6]
P2[1]
3
SEG1
P0[5]
P2[2]
4
SEG2
P0[4]
P2[3]
5
SEG3
P0[3]
P2[4]
6
SEG4
P0[2]
P2[5]
7
SEG5
P0[1]
P3[6]
8
SEG6
P0[0]
P3[7]
9
SEG7
P7[1]
P9[0]
10
SEG8
P4[0]
P9[1]
11
SEG9
P3[7]
P9[2]
12
SEG10
P3[6]
P9[3]
13
SEG11
P3[5]
P6[1]
14
SEG12
P3[4]
P6[0]
15
SEG13
P3[3]
P6[3]
16
SEG14
P3[2]
P4[0]
17
SEG15
P3[1]
P4[1]
18
COM2
P3[0]
P3[4]
19
COM0
P6[5]
P6[5]
20
SEG16
P6[4]
P5[5]
21
SEG17
P6[2]
P5[6]
22
SEG18
P6[1]
P4[4]
23
SEG19
P6[0]
P4[5]
24
SEG20
P2[7]
P4[6]
25
SEG21
P2[6]
P4[7]
26
SEG22
P2[5]
P3[1]
27
SEG23
P2[4]
P3[0]
28
SEG24
P1[3]
P8[7]
29
SEG25
P1[2]
P8[6]
30
SEG26
P1[1]
P8[5]
31
SEG27
P1[0]
P8[4]
32
SEG28
P5[5]
P8[3]
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9
LCD ピン番号
LCD ピン機能
CY8CKIT-43 接続先
CY8CKIT-046 接続先
33
SEG29
P5[3]
P8[2]
34
SEG30
P5[2]
P8[1]
35
SEG31
P5[1]
P8[0]
36
COM1
P5[0]
P5[6]
まとめ
本アプリケーション ノートは PSoC 4 のセグメント LCD 駆動を説明しました。堅牢な静電容量タッチセンスとクラス最高の
低消費電力機能を組み合わせたことにより、PSoC 4 は低消費電力、シングルチップ、ユーザー インターフェースのソリューション
に理想的な選択肢となります。
また本アプリケーション ノートは、PSoC 4 セグメント LCD コンポーネントの手ほどき、低消費電力動作の見本、ユーザー
インターフェースの実装について 4 つのサンプル プロジェクトを紹介しました。
PSoC 4 はプログラマブル アナログおよびデジタル、32 ビット ARM Cortex-M0 マイクロコントローラーやシリアル通信ブロックな
どの多くの付加機能を備えています。これらの機能により、PSoC 4 を使用してまとまったシステム ソリューションを作成でき
ます。
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